
Novost v programu Premiere Pro pri delu z zvokom je: 

- nov panel: »Essential Sound« in  
- novo orodje Remix. 

 

Dodajanje novega zvoka iz zbirke: Adobe Stock  

Poleg uvažanja glasbenih datotek, ki jih vključite v svoje sekvence, lahko v Premiere Pro 
prebrskate in uvozite glasbo tudi iz Adobe Stock Audio s pomočjo panela Essential Sound. 

Zavihek Browse (Prebrskaj) v panelu Essential Sound prikazuje zvočne posnetke iz Adobe Stock, 
ki so pripravljeni za iskanje, pregledovanje in predvajanje. 

Iskalno polje (Search) na vrhu omogoča iskanje posnetkov glede na njihova imena ali 
metapodatke (metadata tags). 

Za omejitev rezultatov iskanja lahko razširite in izberete možnosti pod razdelki Moods 
(Razpoloženje), Genres (Žanri) in Filters (Filtri). 

Pod razdelkom Filters lahko celo določite želeno območje tempa ali trajanja posnetka.  

 

VAJA - Dodajmo predogled zvočnega posnetka iz Adobe Stock v sekvenco 

1. V mapi Sequences (Sekvence) odprite sekvenco Drone Flight. Gre za preprosto 
sekvenco, ki vsebuje samo video posnetke. Predvajalno glavo (playhead) postavite na 
začetek sekvence. 

2. Če panel Essential Sound trenutno prikazuje nastavitve za urejanje (Edit), kliknite 
zavihek Browse (Prebrskaj) na vrhu panela. 

3. Na dnu panela Essential Sound preverite, da je omogočena možnost Timeline Sync 
(Sinhronizacija s časovnico). 

Ko je Timeline Sync vklopljen, se bo vaša sekvenca samodejno predvajala skupaj z izbranim 
zvočnim posnetkom iz Essential Sound panela. Glasba se bo združila z obstoječim zvokom in 
videom, kar vam omogoča, da preizkusite več različnih glasbenih možnosti, še preden katero 
dodate v svojo sekvenco. 

4. V panelu Essential Sound kliknite gumb Play ob katerem koli zvočnem posnetku iz 
Adobe Stock, da ga predvajate skupaj s svojo sekvenco. Nato poskusite predvajati še 
nekaj drugih zvočnih možnosti za primerjavo. 

Nasvet: Lahko kliknete kjerkoli znotraj predogleda valovne oblike zvočnega posnetka iz Adobe 
Stock, da preskočite na drug del zvoka. 

Če je Timeline Sync (Sinhronizacija s časovnico) omogočena, se bo tudi predvajalna glava v 
časovnici premaknila za ustrezno dolžino — tako bosta zvok in slika ostala usklajena. 

 



5. Povlecite enega izmed zvočnih posnetkov iz panela Essential Sound v sekvenco. 
Postavite ga na začetek zvočne steze Audio 1. Pazite, da posnetek povlečete s klikom na 
njegovo ime ali opis — ne na valovno obliko. 

Posnetek se bo samodejno pojavil tudi v novi mapi Stock Audio Media v oknu Project (Projekt). 

6. Predvajajte svojo sekvenco. 
Zvočni posnetki, ki jih iz panela Essential Sound dodate v sekvenco, so privzeto v 
kakovosti za predogled (preview quality). 
Polno kakovost lahko pridobite s klikom na gumb License (Licenciraj) v panelu Essential 
Sound ali poleg posnetka v oknu Project. 

Adobe Stock Audio ponuja obsežen katalog glasbe brez avtorskih nadomestil (royalty-free).  

 

Samodejno zniževanje ravni glasbe (Auto-ducking) 

Ena najpogostejših nalog pri delu z avdio mešanico je zniževanje ravni glasbe med deli, kjer je 
prisoten govor. Če imate na primer stezo z glasovno pripovedjo (voice-over), boste morda želeli, 
da se glasba utiša, ko se podajajo informacije, nato pa se hitro spet okrepi in postane 
prevladujoč element v mešanici. Tako delujejo radijski DJ-ji, ko govorijo čez glasbo — glasba se 
samodejno utiša, ko DJ govori. Ta tehnika se imenuje ducking. 

Avdio ključne sličice (keyframes) lahko za ducking dodate ročno, vendar pa obstaja tudi 
avtomatiziran način z uporabo plošče Essential Sound. 

 

VAJA – samodejno zniževanje ravni glasbe 

1. Odprite sekvenco Journey to New York. Prepričajte se, da so vsi posnetki z glasovno 
pripovedjo na zvočni stezi Audio 1 izbrani (pomagate si lahko z orodjem: Track Select 
Foward Tool (A) + Shift). 

2. V plošči Essential Sound (ki bi morala biti že prikazana, saj ste prej izbrali delovno okolje 
Audio), kliknite zavihek Edit, da si ogledate možnosti, povezane z izbranimi posnetki. 

3. Z določitvijo vrste zvoka (audio type) boste pridobili dostop do orodij in kontrol, ki so 
pomembne za to vrsto zvoka. 
Premiere Pro lahko samodejno zazna vrsto zvoka in dodeli pravilne oznake, če 
omogočite možnost Auto Tag. 
Vendar pa morda ne bo mogoče natančno prepoznati vrste zvoka pri krajših posnetkih, 
kot so ti. 

Kliknite gumb Dialogue, da izbranim posnetkom dodelite vrsto zvoka Dialogue. 
Z dodelitvijo oznake Dialogue bo Premiere Pro vedel, da gre za govor, kar je pomembno za 
izvajanje samodejnega duckinga. 

4. Povečajte velikost steze Audio 2, da boste lahko jasno videli valovno obliko posnetka z 
glasbo. Izberite ta posnetek in v plošči Essential Sound izberite vrsto zvoka Music. 

5. V plošči Essential Sound označite polje, da omogočite Ducking, in si oglejte možnosti. 



Če nastavitve ne prikazujejo nobenih vrednosti, dvokliknite vsak drsnik, da obnovite privzete 
nastavitve. 

• Duck Against: Obstaja več vrst zvoka. Izberete lahko, ali naj samodejni ducking sproži 
ena, več ali vse vrste zvoka. Tukaj izvajamo ducking glede na govor (Dialogue), kar je 
privzeta nastavitev. 

• Sensitivity: Višja kot je občutljivost, nižja raven zvoka je potrebna, da se sproži ducking. 

• Duck Amount: Za koliko decibelov se bo raven glasbe znižala. 

• Fade Duration: Čim počasnejša je nastavitev prehoda (fade), tem dlje bo trajalo, da se 
glasba utiša in nato spet poveča. 

• Fade Position: Prilagodi časovni zamik za dodane prehode — torej, kdaj se ključne 
sličice začnejo. 

• Generate Keyframes: Kliknite ta gumb, da uporabite nastavitve in dodate ključne sličice 
posnetku z glasbo. 

6. Izbira pravih nastavitev za ducking je znanost in umetnost obenem, izbira pa je odvisna 
od vrste zvoka, s katerim delate. Ključnega pomena je eksperimentiranje. 

Za to zvočno gradivo poskusite te nastavitve: 

• Duck Against: Dialogue Clips (privzeto že izbrano) 

• Sensitivity: 6.0 

• Duck Amount: –8.0 dB 

• Fades: 500 ms 

• Fade Position: 5.0 

7. Kliknite Generate Keyframes. 
Ključne sličice bodo dodane učinku Amplify, ki ga funkcija ducking samodejno uporabi 
na posnetku z glasbo. Učinek in ključne sličice se prikažejo v plošči Effect Controls in v 
Timeline. 

8. Predvajajte sekvenco in poslušajte rezultat. Ni popolno, a je že bližje končani mešanici. 

Nastavitve duckinga lahko prilagajate in večkrat kliknete gumb Generate Keyframes, da 
odstranite in ponovno ustvarite ključne sličice, kar omogoča varno in enostavno 
eksperimentiranje. 

Prav tako lahko ročno prilagajate že dodane ključne sličice — lahko jih odstranite, premikate ali 
dodajate kadarkoli. 

 

 

 

 

 



Retiming music with Remix (Prilagajanje dolžine glasbe z orodjem Remix) 

Glasba ima lahko izjemen vpliv na vizualno pripovedovanje. Tako kot bi akcijski film brez 
vznemirljive glasbene podlage deloval medel, lahko tudi najbolj subtilen dialog oživi ob pravem 
glasbenem ozadju. Na več načinov glasba gledalcem pove, kako naj se počutijo, zato je 
ključnega pomena, da jo izberemo pravilno. 

Morda najdete točno tisto skladbo, ki si jo želite, in imate celo pravice za njeno uporabo v 
projektu — nato pa ugotovite, da je predolga ali prekratka za vaše vizualne vsebine. Kaj zdaj? 

Dolga leta je bila rešitev v tem, da ste ure in ure natančno rezali in sestavljali dele glasbenega 
posnetka, v upanju, da ga boste lahko neopazno podaljšali ali skrajšali — pogosto brez uspeha, 
saj je zelo težko preprečiti moteče prehode. 

Na srečo ima Premiere Pro izjemno rešitev: orodje Remix. 
Ta avtomatizirana, inteligentna tehnologija analizira glasbo in uporabi točno prave reze, da 
doseže želeno dolžino — v nekaj sekundah. 

Najboljši način za učenje orodja Remix je, da ga preizkusite v praksi: 

VAJA 1 – uporaba orodja Remix 

1. V plošči Timeline kliknite ime sekvence Drone Flight, da jo izberete. 
2. Izberite glasbeni posnetek iz Adobe Stock, ki ste ga dodali prej, in ga izbrišite. 
3. Iz mape Music povlecite posnetek Ambient Heavens – Patrick Cannell na začetek 

zvočne steze Audio 1. 

Ta glasbeni posnetek je predolg za sekvenco. Uporabili boste orodje Remix, da ga prilagodite. 

4. Kliknite in pridržite orodje Ripple Edit, da razširite dodatne možnosti orodij, nato izberite 
orodje Remix. 

5. Preverite, da je možnost Snapping (pripenjanje) omogočena v plošči Timeline, nato 
uporabite orodje Remix, da skrajšate konec glasbenega posnetka, dokler se ne pripne 
na konec video posnetkov. 
Prikaže se vrstica napredka, ki prikazuje potek analize posnetka, in dolžina posnetka se 
posodobi. 

Bele nazobčane črte označujejo mesta, kjer je bil glasbeni posnetek obdelan. Poskusite 
predvajati čez te dele — težko jih je zaznati. To je čar orodja Remix! 

Opazili boste, da glasbeni posnetek nima točno dolžine, ki ste jo nastavili. Remix pametno oceni 
posnetek in določi novo dolžino, ki najbolje omogoča tekoče prehode. 

VAJA 2 

1. Remix deluje tudi za podaljševanje posnetkov. Izbrišite posnetek Ambient Heavens – 
Patrick Cannell. 

2. Iz mape Music povlecite glasbeni posnetek Ghost Reverie na začetek zvočne steze 
Audio 1. 

3. Uporabite orodje Remix, da podaljšate posnetek tako, da ustreza dolžini video 
posnetkov. Preglejte rezultat. 



Če ugotovite, da je rezultat orodja Remix slab, lahko eksperimentirate z natančnimi nastavitvami 
v razdelku Duration plošče Essential Sound. 

 

 

S pomočjo panela: »Essential Sound« lahko zvok tudi izboljšamo in sicer: 

• Izboljšanje zvoka govora. 

• Čiščenje hrupnega zvoka. 

V Adobe Premiere Pro boste našli veliko zvočnih učinkov. Ti učinki se lahko uporabijo za 
spreminjanje višine tona, ustvarjanje odmeva, dodajanje reverba (odboja zvoka) in 
odstranjevanje šuma traku. Za učinke lahko nastavite ključne sličice (keyframes) in njihove 
nastavitve prilagajate skozi čas. 

 

Izboljševanje zvoka 

 

Video produkcija redko ustvari popoln zvok. Verjetno boste morali v postprodukciji uporabiti 
zvočne učinke, da popravite nekatere težave in izboljšate kakovost zvoka — še posebej pri 
govoru — saj so občinstva zelo občutljiva na težave pri zvoku človeškega glasu. 

Vsa zvočna oprema ne predvaja vseh zvočnih frekvenc enakomerno. Na primer: poslušanje 
globokih basov na prenosnem računalniku ni nikoli enako kot poslušanje na večjih zvočnikih. 

Pomembno je, da svoj zvok poslušate s kakovostnimi slušalkami ali studijskimi monitorji 
(zvočniki), da se izognete temu, da bi pri prilagajanju zvoka nehote odpravljali napako svoje 
predvajalne opreme. 

Profesionalna zvočna oprema za nadzor zvoka je natančno kalibrirana, da zagotavlja 
enakomerno predvajanje vseh frekvenc — tako imenovani "ravni" (flat) odziv — kar vam daje 
zaupanje, da boste ustvarili dosleden zvok za svoje poslušalce. 

Koristno pa je tudi poslušanje zvoka na slabših zvočnikih. To vam omogoča, da preverite, ali je 
zvok še vedno dovolj jasen in da nizke frekvence ne povzročajo popačenja. 

Premiere Pro ponuja različne uporabne zvočne učinke, ki so na voljo v plošči Effects (Učinki), 
med njimi: 

• Parametric Equalizer (Parametrični izenačevalnik): Omogoča vam natančne 
prilagoditve ravni zvoka pri določenih frekvencah. 

• Studio Reverb (Studijski odmev): Poveča "prisotnost" v posnetku z dodajanjem odmeva 
— na primer simulira akustiko večjega prostora. 

• Dynamics Processing (Obdelava dinamike): Omogoča natančne prilagoditve dinamike 
zvoka, kot so kompresija, razširjanje (expansion) ali omejevanje ravni zvoka (limiting). 

 



• Bass (Nizki toni): Ta učinek omogoča prilagajanje nizkofrekvenčnih tonov (basov) v 
zvočnem posnetku. Zelo dobro deluje pri posnetkih z govorom, še posebej pri moških 
glasovih, saj poudari globino in toplino glasu. 

• Treble (Visoki toni): Ta učinek prilagaja visokofrekvenčne tone v zvočnem posnetku. 
Uporablja se za izboljšanje jasnosti in razumljivosti govora ali drugih zvokov. 

 

Razširite svoje znanje o zvočnih učinkih v programu Premiere Pro tako, da eksperimentirate. 
Tako kot video učinki so tudi zvočni učinki v Premiere Pro nedestruktivni, kar pomeni, da ne 
spremenijo vaših izvornih zvočnih datotek. 

Na posamezen posnetek lahko dodate poljubno število učinkov, spreminjate njihove nastavitve, 
poslušate rezultat in jih nato po potrebi izbrišete ter začnete znova. 

 

Vaje v nadaljevanju temeljijo predvsem na uporabi panela: Essential Sound, ki ponuja vrsto 
profesionalnih prilagoditev in učinkov, ki jih je enostavno uporabiti. Ti temeljijo na običajnih 
delovnih postopkih za standardne vrste medijev, kot sta dialog in glasba. 

Izbira posamezne oznake prikaže različna orodja, ki so primerna za to vrsto medija. Zvok dialoga 
ima več možnosti kot katera koli druga vrsta — in to z dobrim razlogom! Zvok dialoga je verjetno 
najpomembnejši, medtem ko so glasba, vnaprej pripravljeni zvočni učinki (SFX) in ambientalni 
zvoki pogosto že zmešani in pripravljeni za uporabo. 

Vsaka prilagoditev, ki jo uporabiš s ploščo Osnovni zvok, dejansko doda enega ali več zvočnih 
učinkov izbranim posnetkom in prilagodi nastavitve teh učinkov. Na nek način plošča Osnovni 
zvok (Essential Sound) ponuja odlično bližnjico za doseganje vrhunskih rezultatov z enostavnimi 
kontrolami. Po uporabi prilagoditev v plošči Osnovni zvok (Essential Sound) lahko izbereš 
posnetek in natančno nastaviš učinke v plošči Krmilniki učinkov (Effect Controls). 

 

VAJA - Normalizacija glasnosti 

1. Odpremo sekvenco 02 Loudness. 

2. Povečaj višino zvočne steze Audio 1 in se nekoliko približaj (zoom), da boš jasno videl 
posnetke z glasom. 

3. Predvajaj sekvenco, da slišiš različne nivoje glasnosti teh posnetkov. 

4. Izberi vse posnetke z glasom. Najlažje jih izbereš tako, da jih obkrožiš z miško (lasso), pri 
tem pa pazi, da ne izbereš tudi drugih posnetkov v sekvenci. 

5. V plošči Osnovni zvok klikni gumb Dialog (Dialogue). S tem tem posnetkom dodeliš vrsto 
zvoka dialog. 

6. Če je potrebno, klikni naslov kategorije Glasnost (Loudness), da prikažeš možnosti za 
nastavitev glasnosti. Klik na kategorijo deluje podobno kot klik na trikotnik za razkrivanje 
nastavitev v plošči Krmilniki učinkov – z enim klikom prikažeš ali skriješ možnosti. 

7. Klikni Samodejna poravnava (Auto-Match). 



Premiere Pro analizira vsak posnetek in samodejno prilagodi ojačitev zvoka (Audio Gain), da 
doseže standardno raven –23 LUFS za televizijski dialog. LUFS pomeni enote glasnosti glede na 
polno lestvico (Loudness Units relative to Full Scale). 

Tradicionalno so zvočne nivoje merili v decibelih (dB), kar je še danes pogosta praksa. Meritev 
najvišjega nivoja ne upošteva celotne energije zvočne sledi, zato lahko vsi deli posnetka zvenijo 
nenaravno glasno – kar je pogosto v televizijskih oglasih. Lestvica glasnosti (Loudness scale) 
rešuje to težavo z merjenjem skupne zvočne energije skozi čas (v LUFS), kar omogoča bolj 
uravnotežen zvok znotraj dovoljenih mej. 

Popravljanje zvoka 
Ne glede na to, kako zelo se trudiš zajeti čist zvok na terenu, je verjetno, da bo del tvojega 
posnetka vseboval neželeni šum iz ozadja. 

Plošča »Essential Sound« ponuja več načinov za čiščenje posnetkov dialoga. Oglej si kategorijo 
Popravi (Repair), kjer se prikažejo možnosti za popravilo dialoga: 

• Zmanjšaj šum (Reduce Noise): Zmanjša neželene zvoke v ozadju, kot so hrup klimatske 
naprave, šumenje oblačil ali šum ozadja. 

• Zmanjšaj bobnenje (Reduce Rumble): Zmanjša nizkofrekvenčne zvoke, kot so motorni 
hrup ali določene vrste vetrovnega hrupa. 

• Odstrani brnenje (DeHum): Zmanjša električno motnjo, t. i. brnenje. V Severni in Južni 
Ameriki je to običajno pri 60 Hz, v Evropi, Aziji in Afriki pa pri 50 Hz. Če je bil tvoj mikrofon 
blizu napajalnega kabla, se lahko pojavi ta moteč, a enostavno odstranljiv zvok. 

• Zmanjšaj sikanje (DeEss): Zmanjša ostre, visokofrekvenčne »s«-zvoke, ki so pogosti pri 
izgovorjavi soglasnikov v govoru. 

• Zmanjšaj odmev (Reduce Reverb): Zmanjša učinek odbitih zvokov, da postane glas 
jasnejši. Pri snemanju v prostoru z veliko odbojnih površin se lahko zvok odbije nazaj v 
mikrofon kot odmev. 

 

VAJA - Odpravljanje električnega brnenja 

1. Odpri sekvenco 03 Noise Reduction. 

2. Predvajaj sekvenco, da poslušaš glas v ozadju. 
To je preprosta sekvenca z glasom, ki spremlja vizualne elemente. V zvoku je slišno 
glasno električno brnenje zaradi motenj. Če brnenja ne slišiš, tvoji zvočniki morda ne 
predvajajo dovolj nizkih frekvenc — poskusi poslušati s slušalkami. 

3. Izberi posnetek z glasom v sekvenci. 
Posnetek je že označen kot dialog v plošči Essential Sound, zato so prikazane možnosti 
za dialog. 

4. Če razdelek Popravi (Repair) še ni odprt, klikni njegov naslov, da prikažeš možnosti. 
Označi DeHum, da ga vključiš. 



5. Predvajaj sekvenco, da slišiš razliko. 
Učinek je občuten! Električno brnenje je bilo glasno, vendar na specifični frekvenci, kar 
omogoča enostavno odstranitev. 

Če uporaba funkcije DeHum vpliva na razumljivost govora, poskusi prilagoditi količino z 
drsnikom. 
Ta primer vsebuje brnenje pri 60 Hz, zato je privzeta nastavitev 60 Hz primerna. Če ne deluje, 
poskusi preklopiti na 50 Hz. 
Po prilagoditvi nastavitev DeHum preveri začetek posnetka — morda bo ostal še rahel brum 
pred začetkom popravka. Da to odstraniš, dodaj kratek preliv (crossfade) na začetek posnetka. 

 

Zmanjševanje šuma in odmeva 
 

Poleg specifičnih vrst šuma v ozadju, kot sta brnenje in bobnenje, Premiere Pro ponuja 
napredna orodja za zmanjševanje šuma in odmeva. Ti učinki za čiščenje zvoka imajo enostavne 
kontrole v plošči Osnovni zvok, naprednejše možnosti pa so na voljo v plošči Krmilniki učinkov. 

VAJA - Zmanjševanje šuma 

1. Odpri sekvenco 04 Auto Noise and Reverb. Ta sekvenca vsebuje posnetke z motečim 
šumom v ozadju in odmevom. Predvajaj sekvenco, da se seznaniš z zvokom — veliko je 
neželenega šuma in odmeva zaradi snemanja v hrupnem okolju. 

(Posnetki v tej sekvenci so že označeni kot dialog v plošči Osnovni zvok, uporabljena pa je bila 
tudi možnost Samodejna poravnava (Auto-Match) v kategoriji Glasnost.) 

2. Izberi prvi posnetek v sekvenci. V razdelku Popravi (Repair) plošče Osnovni zvok vklopi 
možnost Zmanjšaj šum (Reduce Noise). Privzeta vrednost intenzivnosti učinka je 5.0. 
NAMIG: Vsak drsnik v plošči Osnovni zvok lahko ponastaviš na privzeto vrednost z 
dvojnim klikom. 

3. Predvajaj posnetek, da slišiš razliko. Močan bobneč šum, ki se začne okoli 00:00:10:00, 
je takoj precej tišji. 

4. Tako kot pri večini učinkov boš najboljši rezultat dosegel z metodo poskusa in napake. 
Prilagajaj intenzivnost med predvajanjem. Če je učinek premočan, bo govor zvenel 
popačeno; če je prešibek, bo ostalo preveč šuma. Ko zaključiš s preizkušanjem, pusti 
nastavljeno vrednost na 5.0. 

5. Prepričaj se, da je prvi posnetek še vedno izbran v časovnici, nato odpri ploščo Krmilniki 
učinkov (Effect Controls). Klikni gumb Uredi (Edit) za dostop do naprednih nastavitev 
učinka DeNoise, ki ga je Premiere Pro dodal ob vklopu funkcije Reduce Noise. 

Povezava med ploščama Osnovni zvok in Krmilniki učinkov: 
Ko vklopiš Reduce Noise, Premiere Pro doda učinek DeNoise v izbrani posnetek, kar je vidno v 
plošči Krmilniki učinkov. Pravzaprav vsak popravek v plošči Osnovni zvok ustvari ali spremeni 
učinek, ki je tam dostopen. Ploščo Osnovni zvok si lahko predstavljaš kot pametno bližnjico do 
optimiziranih zvočnih učinkov, ki jih lahko dodatno nastaviš. Če plošče Effect Controls ne vidiš, 
jo lahko odpreš prek menija Window. 



Odpre se okno Clip Fx Editor - DeNoise. Med predvajanjem graf prikazuje zaznani šum (modro 
spodaj) in popravek (rdeče zgoraj). Medtem ko je učinek odprt, lahko še vedno uporabljaš 
časovnico. 

Na levem koncu grafa so nizke frekvence, na desnem pa visoke. 

6. Predvajaj posnetek in bodi pozoren na graf, ko ni govora, ampak samo bobnenje. Jasno 
je, da je šum v nizkih frekvencah. 

Poglej nastavitve: 

1. Prednastavitve (Presets): Izbereš lahko "Heavy" ali "Light" odstranjevanje šuma; ti 
možnosti vplivata na nastavitev Amount. 

2. Intenzivnost (Amount): Prilagodi intenzivnost učinka. 

3. Samo šum (Output Noise Only): Vklopi to možnost, da slišiš samo šum, ki se 
odstranjuje — uporabno za preverjanje, ali odstranjuješ tudi zaželen zvok. 

4. Ojačitev (Gain): Z zmanjševanjem šuma se zniža tudi splošna raven zvoka. Tu lahko 
prilagodiš ojačitev in uravnotežiš zvok. 

Nastavitev Obseg obdelave (Processing Focus) omogoča ciljno odstranjevanje šuma glede na 
frekvenčno območje. Privzeto se učinek uporablja na celotnem spektru, lahko pa ga usmeriš le 
na določene frekvence. Ikone prikazujejo območja — ob lebdenju nad njimi se prikaže opis. 

7. Klikni možnost Fokus na nizke frekvence (Focus On Lower Frequencies) in ponovno 
predvajaj posnetek. Zvok je že boljši, zato poskusimo učinek še okrepiti. 

8. Povleci drsnik Amount na približno 80 % in predvajaj posnetek. Nato poskusi še s 100 % 
in ga ponovno poslušaj. 
OPOMBA: Ko spremeniš nastavitve učinka, bodo povezane možnosti v plošči Osnovni 
zvok označene s trikotnikom, ki nakazuje, da si prilagodil nastavitve. Morda bo treba 
najprej zapreti urejevalnik učinkov, da se trikotnik prikaže. 

Ker je poudarek na nizkih frekvencah, je tudi pri največji intenzivnosti govor še vedno razločen, 
medtem ko je bobnenje skoraj popolnoma odstranjeno. Kljub naprednim možnostim je za 
najboljši rezultat vedno potrebno nekaj preizkušanja. 

9. Za zdaj nastavi vrednost Amount na 80 % in zapri okno Clip Fx Editor – DeNoise. 

 

VAJA - Zmanjševanje odmeva 

Možnost Zmanjšaj odmev (Reduce Reverb) deluje podobno kot Zmanjšaj šum (Reduce 
Noise). 

Poskusimo: 

1. Poslušaj drugi posnetek v sekvenci. Zvok vsebuje močan odmev, ki je posledica trdih 
površin na lokaciji snemanja, kjer se je zvok odbijal nazaj proti mikrofonu. 
Šum v ozadju pri tem posnetku ni tolikšna težava, vendar je odmev precej izrazit. 

2. Izberi posnetek in v razdelku Popravi (Repair) plošče Osnovni zvok vklopi možnost 
Zmanjšaj odmev (Reduce Reverb). 



Razlika bo zelo opazna! Tako kot pri učinku za šum tudi tukaj eksperimentiraj z 
intenzivnostjo, da dosežeš najboljše ravnovesje med učinkom in naravnim zvenom 
govora. 

Ko izbereš Reduce Reverb, Premiere Pro samodejno doda učinek DeReverb. Do nastavitev 
lahko dostopaš v plošči Krmilniki učinkov (Effect Controls). 

3. Klikni gumb Uredi (Edit) za ta učinek v plošči Effect Controls, nato predvajaj del 
drugega posnetka v časovnici, da se graf v oknu Clip Fx Editor – DeReverb posodobi. 

Čeprav so barve nekoliko drugačne, so nastavitve DeReverb skoraj enake kot pri DeNoise. 
Opazil boš tudi možnost Samodejna ojačitev (Auto Gain) v zgornjem desnem kotu. 
Pri zmanjševanju odmeva se splošna raven zvoka običajno zmanjša, zato Auto Gain samodejno 
kompenzira izgubo glasnosti, kar olajša nastavitev učinka. 

4. Preveri, da je Auto Gain vklopljen, nato predvajaj posnetek in primerjaj rezultat. Ko si 
zadovoljen, zapri okno nastavitev DeReverb. 

5. V tej sekvenci sta še dva posnetka za eksperimentiranje. Poskusi kombinirati učinka 
Reduce Noise in Reduce Reverb z nižjimi vrednostmi za bolj subtilen rezultat. 

 

Izboljšanje govora 

Funkcija Enhance Speech v plošči Osnovni zvok uporablja Adobe Sensei GenAI za ustvarjanje 
novega, izboljšanega zvoka na podlagi izvirnega posnetka. Na voljo sta le gumb Enhance in 
drsnik Mix Amount za mešanje med izvirnim in izboljšanim zvokom. Obdelava poteka lokalno 
na računalniku. 

V kategoriji Clarity so na voljo tri hitre možnosti za izboljšanje jasnosti govora: 

• Dynamics: uravnava razpon med najtišjimi in najglasnejšimi deli, 

• EQ: prilagaja glasnost po frekvencah s pomočjo prednastavitev, 

• Vocal Enhancer: izboljša jasnost govora glede na ton glasu (visok ali nizek). 

Vsaka nastavitev lahko koristi različnim vrstam posnetkov, zato je priporočljivo eksperimentirati. 

VAJA – izboljšanje govora 

1. Odpri sekvenco 05 Clarity. 
Ta sekvenca vsebuje enako vsebino kot 03 Noise Reduction, vendar ima dva različna 
posnetka govora. Prva različica je čistejša od druge. 

2. Poslušaj prvi posnetek govora. 

3. Izberi ta posnetek in v plošči Osnovni zvok se pomakni do možnosti Jasnost (Clarity). 
Morda bo treba klikniti naslov razdelka, da se prikažejo nastavitve. 

4. Označi možnost Dinamika (Dynamics) in eksperimentiraj z različnimi nivoji. Med 
predvajanjem sekvence lahko prilagajaš nastavitve v živo. Ko preizkusiš nekaj vrednosti, 
možnost Dynamics izklopi. 



5. Označi EQ in preizkusi različne prednastavitve (Presets). Nekatere, kot je Old Radio, 
ustvarijo zelo izrazite učinke! 
Ko izbereš EQ-prednastavitev, se prikaže diagram prilagoditev, ki temelji na učinku 
Parametrični izenačevalnik (Parametric Equalizer). Z drsnikom Amount lahko prilagodiš 
moč učinka. 

6. Predvajaj drugi posnetek govora. 

7. Izberi drugi posnetek in v razdelku Clarity vklopi Vocal Enhancer, nato preveri, ali je 
izbrana možnost High Tone. 

8. Predvajaj posnetek in med predvajanjem vklapljaj/izklapljaj Vocal Enhancer, da slišiš 
razliko. 

Razlika je subtilna — za jasnejše zaznavanje izboljšav priporočamo uporabo slušalk ali 
kakovostnih monitorjev. Ta možnost izboljša razumljivost govora, pogosto tako, da zmanjša moč 
nizkofrekvenčnih zvokov. 

Dodatno: Pod razdelkom Jasnost (Clarity) v plošči Osnovni zvok se nahaja razdelek Ustvarjalno 
(Creative). 

Ta vsebuje le eno nastavitev: Odmev (Reverb). Učinek je lahko podoben snemanju v veliki sobi z 
veliko odbojnimi površinami ali pa bolj subtilen. 

Eksperimentiraj s tem učinkom na prvem posnetku govora v sekvenci 05 Clarity. 

Tudi majhna količina odmeva lahko “zgosti” glas in mu doda več prisotnosti. 

 

VAJA - Odprava šuma s pomočjo programa: Adobe Audition 

1. Odpri sekvenco 09 Send to Audition. 
2. Z desnim klikom klikni posnetek Noisy Audio.aif v časovnici in izberi Edit Clip In Adobe 

Audition (Uredi posnetek v Adobe Audition). 

Ustvari se nova kopija zvočnega posnetka (z dodatkom "Audio Extracted" v imenu) in se doda v 
projekt, tako v isti mapici kot izvirnik, kot tudi v zamenjavi z izvirnim posnetkom v sekvenci. 
Odpre se program Audition skupaj z novim posnetkom. 

  

3. V Auditionu se mora stereo posnetek prikazati v urejevalnem podoknu (Editor panel). 
Prikazana je velika valovna oblika (waveform). Za uporabo naprednih orodij za 
odstranjevanje šuma je treba najprej določiti del posnetka, ki vsebuje samo šum. 

4. Če pod valovno obliko ne vidiš prikaza Spektralne frekvence (Spectral Frequency 
Display), klikni gumb Show Spectral Frequency Display na vrhu okna. Predvajaj 
posnetek — začetek vsebuje nekaj sekund samo šuma, kar je idealno za izbor. 

5. Z orodjem Time Selection (ikona v obliki črke I v orodni vrstici) povleci, da označiš tihi 
del na začetku posnetka — to je del s šumom. 

6. Ko je izbor aktiven, izberi Effects > Noise Reduction/Restoration > Capture Noise 
Print (ali pritisni Shift+P). V potrditvenem oknu klikni OK. 



7. Nato izberi Effects > Noise Reduction/Restoration > Noise Reduction (process) (ali 
pritisni Shift+Command+P na macOS ali Shift+Ctrl+P na Windows). Odpre se novo 
okno za obdelavo šuma. 

8. Klikni Select Entire File, da izbereš celoten posnetek. 
9. Označi Output Noise Only, da slišiš samo šum, ki ga boš odstranil — to pomaga 

natančneje oceniti, ali odstranjuješ tudi del govora po nesreči. 
10. Klikni Play in prilagajaj drsnike Noise Reduction in Reduce By, da odstraniš šum. Pazi, 

da ne zmanjšaš preveč govora. 
11. Odznači Output Noise Only in poslušaj očiščeni posnetek. Če rezultat ni dober, ponovi 

postopek z drugim izbranim delom šuma. 
12. Ko si zadovoljen z rezultatom, klikni Apply (Uporabi). 
13. Izberi File > Close in shrani spremembe. 
14. Shranjevanje v Audition samodejno posodobi posnetek v Premiere Pro. Preklopi nazaj v 

Premiere Pro in poslušaj očiščeni zvočni posnetek. Audition lahko zdaj zapreš. 

 

  

  


